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Objectives

Upon completion of this module, participants will be able to:

1.    Perform skills covered in Outlook module one;

2.    Manage and manipulate the Workspace layout and appearance;

3.    Create, manage and organize Folders;

4.    Sort, manage and categorize messages;

5.    Request Message and Read receipts;

6.    Identify and use the Search feature;

7.    Set up and manage automatic message replies;

8.    Apply rules to messages and calendars;

9.    Identify parts and features of the Outlook calendar;

10.  Explore various Calendar views;

11.   Use and Customize the Calendar;

12.   Create and work with Appointments, Events, and 

	 Meeting Requests;

13.   Respond to Meeting Requests;

14.   Create and work with Tasks;

15.   Customize Toolbars, Menu Bars and Calendar Properties;

16.   Share Calendar information and apply Permission levels;

17.   Define and know how to download Instant Search component;

18.   Use the Outlook help feature.
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Overview:

We will begin with a quick review-activity of the skills covered in Outlook Module I.  
Participants must be able to compose, send and receive e-mail messages; create and 
customize Contacts and Insert a Signature. 

Pre-Requisite Activity: Module 2
This activity will have you demonstrate and reinforce the skills you will need in order 
to complete this module.  You will compose, format and print an e-mail with delivery 
options; create a signature and create a contact.

Guidelines:

Steve Ballmer is the Chief Executive Officer of Microsoft Corp, the world’s leading 
manufacturer of software for personal and business computing. Ballmer joined 
Microsoft in 1980 and has headed several Microsoft divisions, including operations, 
operating systems development, and sales and support. In July 1998, he was 
promoted to president, and was named CEO in January 2000.

With the launch of Microsoft Office 2007 and Vista Operating System you may have 
questions you would like to ask him.  Use your Outlook skills to compose an e-mail 
to the Microsoft CEO (sballmer@msoffice.net) asking him at least two questions 
regarding the new and improved Outlook features. 

Perform the following tasks (15 minutes):

1.    Open Outlook;

2.    Insert the Contact information for Microsoft Office CEO and your instructor in an addressbook folder 
named “Workshop”.

3.    Create a personal Signature, with your Name, Title and Phone Number, using Verdana, 12 pt Font;

4.    Create a New E-mail message addressed to Steve Ballmer and cc your Instructor;

5.    The Subject of the e-mail should read: “Questions on New Features”;

6.    Compose a message explaining how you use Outlook and what you want to know about one or several 
features found in Microsoft Office Outlook 2007;

7.    Format your message to include Bold headings, Bullets or Numbering and two different size Fonts;

8.    Spell Check your message;

9.    Print your message to the default printer and turn it in to your instructor.

10.  Save in Draft folder, DO NOT SEND and Close Outlook 2007.
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Personalize Your Workspace

Increase Workspace

The Outlook program window includes six areas in which you work with your Outlook 
items.  You may find that you don’t need all the available tools, or would like more 
space for the main work area.  You can easily change the appearance and layout of the 
workspace in several ways.  Here are a few:

Menu bar - can be moved to any side of the program window or have it float anywhere on your screen.

	

Toolbars - by default show command buttons frequently used in the File, Edit, and Actions categories.  
Other toolbars available for display are the Advanced and Web toolbar.  You can hide or display 
toolbars by just right-clicking anywhere on the menu bar.

	

Navigation Pane - appears on the left side of the Outlook window.  Its content changes depending on what 
you are viewing.  It can be minimized and the appearance and content can be changed.

	

Inbox - appears in the center of the window.  Its view can be re-sized and it allows you to display and 
organize content in many ways.

Reading Pane - displays a preview of a selected message, appointment, or attached file.  This pane can be 
displayed to the right of or below the Inbox, or closed.

To-Do bar - appears to the right-side of the Outlook window, displaying calendar(s), upcoming 
appointments, and task list.  It can be minimized, rearranged and its content can be changed.  

You try it!  Personalize your workspace!

1.  Minimize the Navigation pane.
2.  Re-size the Inbox to be 50/50 with your Reading pane and Arrange by Subject.
3.  Display the Reading pane below the Inbox
4.  Minimize and Remove Tasks from the To-Do Bar.

Activity 1



�

Microsoft Outlook 2007 - Module 2   

Managing Messages:

Create Folders

Folders can help you organize your 
messages by allowing you to group them by 
topic.  

To help keep various items in order, Outlook 
allows you to create new folders in addition 
to the default folders already provided.  
Follow these steps to create new folders and 
subfolders:

1.    In the Navigation Pane, right-click your 
mailbox.

2.    Click New Folder.

3.    Create New Folder dialog box opens, type a 
name for the folder in the Name text box.

4.    Verify the “Mail and Post items” is selected 
under “Folder contains:”

5.    Select a location for the folder in the “Select 
where to place the folder” scroll box.

6.    Click OK. The new folder is created and 
appears in your Folder list.

To keep your e-mail together in one location, 
it is a good idea to use the Inbox as the 
parent folder.

2

1

3
4

6

5
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Categorize Messages

Managing Messages:

Color adds visibility.  Categories in Outlook 
help you organize and quickly identify items 
using color.  

To assign a color category follow these 
steps:

1.    Right-click the Categories field box next to the 
message subject in the header list.

2.    Click a color category, or click All Categories 
to create and assign a new one.

3.    The category color appears in the message 
header and in the Categories field box in the 
header list.

To rename a category or change its 
color follow these steps:

4.    On the Standard toolbar, click the   
Categorize button, and click All Categories in 
the drop-down menu.

5.    In the Color Categories dialog box, select the 
category that you want to change and do one or 
both of the following:

	 -To rename the category, click the Rename 
button and type the new name

	 -To change its color, click the arrow next to 
Color and select the new color.

You can assign a color category to a 
group of interrelated items — such as 
notes, contacts, appointments, and e-mail 
messages — so that you can quickly track 
and organize them. You can also assign 
more than one color category to items.

1

2

4

5

3
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Update Outlook 2003 colored flags to color categories:

1.    In the Navigation Pane, right-click the top level folder.

2.    Click Properties for “Folder Name.”

3.    On the General tab, click Upgrade to Color Categories.

4.    Click Yes if you receive a prompt asking you if you want to upgrade.

Only flags in your default mailbox will be updated automatically from Microsoft Office Outlook 
2003 follow-up flags to the new Outlook 2007 color categories.  If you have messages in Personal 
Folders or Archive Folders you will need to manually update flagged messages in those folders.

Managing Messages:

Flag Messages

You can use a flag to quickly create a 
follow-up item that can be tracked in the 
To-Do Bar, in your Inbox, and even in the 
Calendar.  Outlook 2007 has replaced 
colored flags with colored categories. You 
can now choose from one of five predefined 
flags or choose a custom flag to help you 
prioritize. 

To Flag a message follow these steps:

1.    Right-click in the Flag Status column  next 
to the message that you want to flag.

2.    Select a flag type or custom flag.

3.    If a custom flag is chosen, the Custom Dialog 
box opens.  Select the flag type and actions you 
want attached to this flag.

4.    Click OK.  Message is flagged.

1

2

3

4
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Sort Messages

Managing Messages:

After categorizing and flagging the 
appropriate messages, you can sort the 
messages by category color.  One way to 
sort the messages by category color is as 
follows:

1.    With the Inbox window active,  click the 
“Arranged By:” bar.

2.    Click Categories in the Arrange By submenu.

In addition, Outlook 2007 allows you to sort 
messages using column headers as your sort 
criterion (when Reading pane is in Bottom 
view).

1

2

Group Messages

Whereas sorting allows you to arrange 
messages in order using a single column as 
the sort criterion, grouping allows you to 
display the messages in groups based on 
one or more columns.  Follow these steps to  
group messages in a message folder:

3.    Open the folder you want to organize. When in 
Bottom view, right-click the column header. 

4.    Choose Group By This Field to group based on 
the selected field.

3

4
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Options Tab

The Options tab is one of the tabs available in the Ribbon of a New E-Mail Message 
Window (see illustration). 

Managing Messages:

The Options tab groups commands related to a variety of optional settings that can be 
applied to messages.  These commands are organized into five groups: 

       Themes - allows you to change the overall design of a message, including colors, fonts and effects

       Fields - allows you to show or hide the “Bcc” or “From” fields from the message window

       Format - allows you to set the format of the message to plain text, HTML and rich text

       Tracking - allows you to set security, importance, sensitivity, delivery and tracking of messages

       More Options - allows you to specify where to save messages, delivery date and time and what e-mail 
address should message replies go to 
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Managing Messages:

Request Message Receipt

A message recipient has the option to 
tell you if a message has been delivered 
and/or read.  The Delivery Receipt is 
automatically generated when the message 
has been delivered to the recipient’s 
mailbox.  The Read Receipt is generated 
when the message is opened.

1.    In an active message. Select Options tab.

2.    In the Tracking group: 

	 -Select Request a Delivery Receipt, to receive 
notification that the message has been received.

	 -Select Request a Read Receipt to receive 
notification that the message has been read.

3.    Click Send.  The message is sent with receipt 
requests.

The option is selected if a checkmark 
appears in the check-box.

1

2

3

You received an e-mail with a Subject line, Smart Art Illustrations.  Using this e-mail message and the con-
cepts, skills and guidelines presented in this module thus far, complete these tasks (15 minutes):

1.    Open the e-mail regarding Smart Art Tags.

2.    Complete the actions requested in the e-mail message.

3.    Set message options to High Priority and Request a Read Receipt.

4.    Flag Recipient to Follow-Up within the next two days.

5.    Create a category named “Workshops” and apply to this message.

6.    Spell check and Send.

Activity 2
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Out of Office Assistant

One improved feature in Outlook 2007 is 
the Out Of Office Assistant.  The Out of 
Office Assistant makes it easy to set up an 
automatic reply message.  To set up an Out 
Of Office message follow these steps:

1.    Click the Tools menu.

2.    Select Out of Office Assistant.

3.    Click to select “I am currently Out of the 
Office”.

4.    Type the automatic reply message you want 
sent to others while you are out.

5.    Rules can be applied to incoming messages (e.g. 
place messages in Out of Office Mail folder).

6.    Click OK.

The Out of Office Assistant command 
does not appear unless you are using 
an Exchange account (collaborative 
communications server for businesses).

Managing Messages:

1

2

3

4

6

6
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The Microsoft Outlook Calendar is the calendar and scheduling component of Outlook, 
and is fully integrated with your Outlook e-mail and contacts. With Calendar, you can 
create appointments and events, organize meetings, and book meeting rooms and other 
resources.

The Calendar Environment

1.  To access the Calendar, click on the icon just below the Mail icon in the 
Navigation pane.

2.  When in the Calendar workspace, the Date Navigator appears at the top of the 
Navigation pane.

3.  The center of the window displays a calendar by Day, Week or Month.

4.  The Calendar display can be customized, in the Tools menu, under Options.

1

2
3

4
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Daily Tasks and To-Do Lists

The Daily Tasks and To-Do Lists are two other key views in the Calendar Environment 
to help manage your workload. 

Time Management:

1.  When the Calendar is viewed by Day or Week, the Daily Tasks List appears at 
the bottom of the screen, and any Tasks are shown there on the date they are due. 

2.  Tasks can also be managed in the Tasks section found on the Navigation Pane.

3.  In all Calendar views, the To-Do List runs vertically down the right side of the 
screen. The To-Do list is an overview of your entire schedule. 

4.  Upcoming Appointments and Tasks are displayed along with the Date 
Navigator.

12

3

4
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Sharing Calendars

You can share calendar information with 
other people in many ways. To share 
your calendar, follow these steps:

1.    In the Calendar window Select “Share My 
Calendar”  on the Navigation pane.

2.    A Sharing Invitation window opens with 
the subject already filled out and the “Allow 
recipient to view your calendar” box checked.

3.    You can also request to see the recipients’ 
calendars by checking the “Request permission 
to view recipient’s calendar” box.

Once you assign your calendar with other 
users, you can then assign each account 
a permission level.  To change sharing 
permissions right-click the shared calendar 
in the Navigation pane, the click “Change 
Sharing Permissions...”.

Time Management:

1

2

3
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Calendar Sharing via E-Mail

A new feature of Outlook 2007, sending 
Calendar information in an e-mail, allows 
you to share calendar information with 
anyone, anywhere who uses HTML capable 
e-mail program.

1.    Compose your e-mail message.

2.  Select the Insert tab.

3.  Click Calendar tool in the Include 
group.

4.  Specify the calendar information 
you want to share in the dialog 
window.

5.  Click OK.  Calendar image will render 
and appear in the body of your e-mail.

Time Management:

2

3

4

5
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Create Appointment

Appointments are activities that you 
schedule in your calendar that do not 
involve inviting other people or reserving 
resources (like in Meetings).  

Follow these steps to create an 
appointment:

1.    Click on the day you want to schedule the 
appointment using the Date Navigator.

2.    The Calendar changes to display the Day 
selected.  Highlight the start time.

3.    Click box to add Appointment, and Name it

4.    Extend the appointment box, to include 
duration time from start to end.

5.    Press Enter > Enter.

6.    The Appointment Form window opens 
allowing you to make changes, add a 
description, etc. using the Ribbon groups and 
commands.

7.    Click the Save & Close button.  Your 
appointment now appears in your calendar.

An Event is an activity that lasts 24 hrs or 
longer (e.g. Trade Show, vacations, etc.).

Time Management:

4

3

2

6

1

7
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Time Management:
Respond to Meeting Request

When you have been invited to attend a 
meeting, a tentative meeting will appear on 
your Calendar and the request will appear 
in your Inbox.  Your reply to the meeting 
request will be sent only to the person who 
originated the request.

1.    Open a received invitation.

2.    At the top of the message window, click the 
appropriate button (Accept, Tentative, or 
Decline).

3.    A dialog box appears with options for your 
response.  Select the appropriate option.

4.    Click OK.

5.    Click Send.  The response is sent and the 
window closes.

As the recipient of a new meeting request, 
you can propose an alternative time to the 
meeting organizer.  When doing this, you 
can see the times available of all those 
invited.  The organizer can agree to your 
proposal and send new invitations or reply 
to you directly.

1

2

3

4
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Instant Search

Microsoft Outlook 2007 provides a new 
fast way to find your information, no matter 
which folder it is in.  Instant Search 
integrates Outlook with Windows Desktop 
Search to enable you to almost instantly 
locate terms in Outlook.

To enable the Instant Search feature in 
Outlook, you must download and Install 
a component for Microsoft Windows.  After 
installing you must restart Outlook.

Searching in Outlook is easy:

1.    Click the Search Inbox field.

2.    Type a word or phrase, then press Enter.

3.    Outlook performs a search and displays a list of 
matching items.

4.    Click “Try Searching Again In All Mail Items” 
to expand the search to all message folders.

5.    Click the  beside the search box to clear the 
search.

1

2

4

5
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Outlook Help

The best way to become familiar with 
Outlook Help is to use it.  The help 
features can increase your productivity and 
reduce the time you spend learning to use 
Outlook.

You can search for information based on 
phrases or key terms.  Follow these steps to 
use help:

1.    Click Microsoft Help  button on the 
Standard Toolbar.

2.    The Outlook Help window opens.

3.    At the top of the Outlook Help window type the 
phrase or key term in the Search text box.

4.    Press Enter.

5.    Select information displayed applicable to your 
search.

6.    Press F1 key or click  button to Close 
Outlook Help Window.

1

3

5

6
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Open the “Writing Tips” e-mail you created and Sent as a Final Activity in Outlook 
Module I.  This message will be integrated as a Task and Scheduled as a Meeting for 
the new Writing Committee.  

You will modify an existing e-mail, integrate a task, schedule a meeting and forward an 
update to all participants of this workshop, including your instructor.  If necessary, you 
will update your Distribution List to include new workshop participants. 

Using these guidelines and the concepts presented in this module complete the tasks 
listed below.

Perform the following tasks in the order listed:

Part I

1.	 Create a Task from the e-mail message “Writing Tips”.

2.  Originate a meeting, inviting all participants of the Outlook II workshop, 
including your instructor.

3.  Send Meeting Request and attach the “Writing Tips” e-mail.

4.  Create an Appointment reminder for the books that you need to pick up at 
the  Bookstore.

Part II

1.	 Reply to Meeting Request from workshop participants with a new proposed 
time.

2.  Search your Inbox for correspondence from “PDWS”.

3.  Close Outlook.

Final Activity: Module 2


